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Abstract
A flow and transport model was created with a graphical 

user interface to simplify the evaluation of nitrogen loading 
and nitrate transport in the mid-Snake region in south-central 
Idaho. This model and interface package, the Snake River 
Nitrate Scenario Simulator, uses the U.S. Geological Survey’s 
MODFLOW 2000 and MOC3D models. The interface, which 
is enabled for use with geographic information systems 
(GIS), was created using ESRI’s royalty-free MapObjects 
LT software. The interface lets users view initial nitrogen-
loading conditions (representing conditions as of 1998), alter 
the nitrogen loading within selected zones by specifying a 
multiplication factor and applying it to the initial condition, 
run the flow and transport model, and view a graphical 
representation of the modeling results.

The flow and transport model of the Snake River 
Nitrate Scenario Simulator was created by rediscretizing and 
recalibrating a clipped portion of an existing regional flow 
model. The new subregional model was recalibrated with 
newly available water-level data and spring and ground-water 
nitrate concentration data for the study area. An updated 
nitrogen input GIS layer controls the application of nitrogen 
to the flow and transport model. Users can alter the nitrogen 
application to the flow and transport model by altering the 
nitrogen load in predefined spatial zones contained within 
similar political, hydrologic, and size-constrained boundaries.

Introduction
Ground-water quality is an ongoing concern in Idaho. 

In 1990, ground water accounted for nearly 85 percent of 
the State’s drinking water; in 1995, it accounted for almost 
95 percent (Solley and others, 1993, 1998). Previous studies 
conducted in Idaho detected high concentrations of nitrate in 
many of the State’s aquifers (Rupert, 1994; Crockett, 1995; 
Rupert and others, 1996). Previous studies also detected 
increasing concentrations of nitrate in a growing number of 

public- and domestic-use wells (Parliman and Young, 1987; 
Young and others, 1987a; Young and others, 1987b; Rupert, 
1994; Clark and Ott, 1996; Rupert and others, 1996). The 
predominant sources of nitrate throughout much of the State 
are inorganic fertilizer, cattle manure, and legume crops 
(Rupert, 1996).

These increasing nitrate concentrations are of particular 
concern in the mid-Snake region of south-central Idaho. The 
region is experiencing substantial growth in some agricultural 
industries associated with the discharge of nitrogen to the 
environment, including dairies and other confined animal 
feeding operations. Gooding, Jerome, and Twin Falls Counties 
are experiencing particular growth in dairy operations (Idaho 
Agricultural Statistics Service, 1999; U.S. Department of 
Agriculture, 1999). These potential new sources of nitrogen 
to ground water are additional to those sources from existing, 
long-term agricultural activities in the region. Because of 
declining ground-water quality in parts of the mid-Snake 
region, the Idaho Department of Environmental Quality 
(IDEQ) designated those areas as priority water-quality 
management areas and targeted them for further study and 
assistance to improve land-use planning, nitrogen monitoring, 
and nitrogen management. At present (2006), planners and 
resource managers in the region lack analysis tools that 
could assist them in land-use planning and in managing and 
protecting water resources. When they attempt to evaluate how 
new and proposed changes to land use might affect their water 
resources, they must do so on an operation-by-operation basis 
without the ability to consider the cumulative effects from all 
nitrogen sources.

In response to these concerns and needs, the IDEQ 
proposed a project to study nitrogen loading effects and to 
develop planning tools to help assess how various land-use 
decisions might affect nitrate concentrations in the region’s 
ground water. The IDEQ asked the U.S. Geological Survey 
(USGS) to conduct an investigation in the mid-Snake region 
of south-central Idaho that comprises Jerome and Minidoka 
Counties and parts of Blaine, Bingham, Butte, Camas, Cassia, 
Elmore, Gooding, Lincoln, Power, and Twin Falls Counties 
(fig. 1).
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Figure 1. Location of the study area, south-central Idaho.
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Purpose and Scope

The purpose of the study was to improve understanding 
of past and future effects of land-use-related nitrogen loading 
on ground water in the study area. Specific objectives were:

Define nitrogen sources to the ground-water system 
and evaluate relative loading from those sources 
as a function of both nitrate availability and the 
hydrogeologic characteristics of the source area.

Use computer simulations to evaluate conceptual 
models of nitrogen loading to and nitrate transport in 
ground water.

Evaluate the utility of applying computer models 
of nitrogen loading and nitrate transport to 
assessing the effects of land-use changes on nitrate 
concentrations in ground water.

Objective 1 was addressed by the investigation reported 
in Skinner and Donato, 2003. Objective 2 was addressed by 
the development of the simulator that accompanies this report. 
The simulator’s graphical user interface (GUI) is enabled for 
use with geographic information systems (GIS). Objective 3 
is addressed by this report, which documents the construction 
and calibration of the subregional flow and transport model, 
provides instructions for using the GIS-enabled GUI, and 
offers guidance for modeling the differences in nitrogen 
loading resulting from changes in land use.

To meet Objective 2, we developed a subregional model 
of the study area, based on a regional, three-dimensional 
ground-water flow model of the eastern Snake River Plain 
(ESRP model) that was developed and calibrated during the 
USGS Regional Aquifer System Analysis (RASA) program 
(Garabedian, 1992). Flow boundary conditions and initial 
estimates of aquifer properties for the new model were derived 
from the calibrated ESRP model.

Estimates of nitrogen loading to the aquifer, as well as 
measured distributions of nitrate concentrations in ground 
water, were used as data sources in a three-dimensional 
ground-water flow and transport model. The transport of 
dissolved nitrate in the ground-water system was simulated 
using the USGS three-dimensional solute-transport model 
MOC3D (Konikow and others, 1996, Kipp and others, 1998). 
Nitrogen input, developed as a separate part of the project 
and described in Skinner and Donato (2003), was used to 
help define nitrogen flux at the surface. Ground-water nitrate 
concentration data were used to calibrate and evaluate the 
transport model.

The scope of computer model development and 
assessment in this component of the study was limited to 
evaluating conceptual models of nitrogen loading, nitrate 
transport, and nitrate distribution in the region’s ground-water 
system. General spatial and temporal trends observed in nitrate 
concentrations were compared with those estimated by the 

1.

2.

3.

simulation model to evaluate the model’s ability to represent 
loading and transport characteristics of the ground-water 
system, including concentrations of nitrate in a series of about 
300 wells throughout the study area, and temporal nitrate 
concentrations from 11 springs that discharge into the Snake 
River.

Success in reproducing observed ground-water nitrate 
concentration trends using flow and transport models and 
estimates of nitrogen loads indicates that there is utility for 
applying computer nitrogen loading and nitrate transport 
models to assess the effects of land use and changes in land 
use on nitrate concentrations in ground water. This finding 
meets Objective 3 of the study. Other ground-water flow 
models that use MODFLOW as a basis for simulations, such 
as the one developed by the State of Idaho for the Snake River 
Plain (Cosgrove and others, 1999), could be adapted for use 
with the GIS enabled graphical simulator that was developed 
for this study.

Description of the Study Area and Its 
Geohydrology

Jerome and Minidoka Counties and parts of Blaine, 
Bingham, Butte, Camas, Cassia, Elmore, Gooding, Lincoln, 
Power, and Twin Falls Counties fall within the study area, 
which comprises 5,341 mi2 in south-central Idaho (fig. 1). The 
study area is in the downstream part of the eastern Snake River 
Plain. About 66 percent of the area is rangeland, 11 percent is 
flood-irrigated land, 21 percent is sprinkler-irrigated land, and 
the remaining 2 percent is comprised of several land-use types. 
The area is predominantly semiarid; mean annual precipitation 
ranges from 8 to 16 in. Therefore, most of the agricultural land 
in the study area lies near the Snake River, a major source of 
water for irrigation.

The ground-water system in the study area is made 
up of two types of aquifers: a regional basalt aquifer and a 
local perched alluvial aquifer. The regional basalt aquifer 
underlying the eastern Snake River Plain provides most of the 
ground water that moves through the study area. The local 
perched alluvial aquifer (fig. 1) overlying the eastern Snake 
River Plain in Minidoka and Cassia Counties is a lesser source 
of ground water and is not included in the flow and transport 
modeling.

Snake River Plain Aquifer
The eastern Snake River Plain aquifer, which 

encompasses the study area, is composed primarily of 
vesicular and fractured olivine basalt flows (Quaternary age) 
of the Snake River Group (Whitehead, 1992). These basalt 
flows average from 20- to 25-ft thick but can, in places, exceed 
1,000-ft thick. The top of the basalt is generally less than 100 
ft below land surface throughout this part of the plain.
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Layered basalt flows in the eastern Snake River Plain 
aquifer yield exceptionally large volumes of water to wells and 
springs. Individual well yields are some of the highest in the 
Nation, typically ranging from 2,000 to 3,000 gal/min to as 
much as 7,000 gal/min with minimal drawdown (Whitehead, 
1992; Lindholm, 1996). Transmissivity is commonly 
100,000 ft2/d and can be as high as 1,000,000 ft2/d (Whitehead, 
1992). Locally, aquifer properties can vary greatly; on a 
regional scale, however, the variability is minimal.

Regional ground water in the eastern Snake River Plain 
aquifer moves from the northeast to the southwest (Rupert, 
1997). Ground water is discharged as springs and seeps to the 
Snake River along the reach bordering Twin Falls, Jerome, and 
Gooding Counties. Ground-water discharge to this reach of the 
Snake River increased considerably from about 1910 through 
the early 1950s (Kjelstrom, 1992). The increase is attributed 
to recharge from surface-water irrigation north of the Snake 
River. Since the early 1950s, ground-water discharge to 
the Snake River has decreased as a result of (1) increased 
ground-water withdrawals for irrigation (Moreland, 1976), 
(2) introduction of more efficient irrigation practices such as 
the conversion from flood to sprinkler irrigation, and (3) local 
droughts (Kjelstrom, 1992).

Perched Aquifer
In the Burley area, an alluvial aquifer is perched above a 

blue-clay layer about 60 to 120 ft below land surface (Rupert, 
1997). Water in this perched aquifer moves northward at the 
southern boundary of the perched aquifer and westward near 
the western boundary. The water level in the perched aquifer 
is about 100 ft above that of the Snake River Plain aquifer. 
The perched aquifer is recharged predominantly from the 
infiltration of irrigation water. Several wells completed in this 
aquifer go dry seasonally after irrigation ceases and become 
operational again after the start of the next irrigation season 
(Rupert 1997).

Development of the Snake River 
Nitrate Scenario Simulator

The water resources of the mid-Snake region have been 
studied in investigations of regional and local hydrologic 
systems of Idaho, including investigations of the Snake River 
Plain in southern Idaho that were part of the USGS RASA 
and National Water-Quality Assessment (NAWQA) programs. 
The RASA and NAWQA programs in southern Idaho have 
produced an assemblage of geologic, hydrologic, and water-
quality information about the region’s ground-water systems, 
as well as computer simulation of those systems. For the 

mid-Snake region study, we used this information, augmented 
with data collected in more recent and ongoing water-quality 
assessments of the area, to develop the Snake River Nitrate 
Scenario Simulator (SRNSS). Because similar information 
resources are available for much of the Snake River Plain, 
the investigation and tool-building approach developed in 
this study might be applicable to other priority water-quality 
management areas of the plain.

Eastern Snake River Plain Model

We based the configuration of the subregional model used 
in this study on a regional, three-dimensional ground-water 
flow model of the eastern Snake River Plain (ESRP model) 
that was developed and calibrated during the USGS RASA 
program (Garabedian, 1992). We derived flow boundary 
conditions and initial estimates of aquifer properties for the 
new subregional model from the calibrated ESRP model. 
Because the ESRP model and its use influenced our modeling 
approach, it is important to note here some of the ESRP 
modeling techniques described by Garabedian (1992) that we 
used to develop the subregional model for this study.

The goal of the eastern Snake River Plain modeling was 
to reproduce known aquifer conditions (for example, head and 
spring discharge) within reasonable ranges of values, and to 
examine the hydrologic effects of changes in model input data 
through sensitivity testing. Initial values of aquifer hydraulic 
properties, recharge, discharge, and pumpage were estimated 
for model input based on geologic and hydrologic information. 
Model output was compared with known aquifer conditions 
to determine whether the initial estimates were reasonable. 
The model was tested to determine its sensitivity to changes in 
transmissivity, storage coefficient, aquifer leakance, recharge, 
riverbed or spring-outlet conductance, ground-water pumpage, 
and boundary flux. Input data were adjusted within reasonable 
ranges to achieve a better fit to known conditions. Adjustments 
were made to least-known and to most-sensitive model 
parameters. Simulation results indicated how the aquifer might 
have responded to past stresses, such as increased pumping 
and reduced recharge, and how the aquifer might respond to 
hypothetical stresses in the future.

To model the regional aquifer system, assumptions were 
made about aquifer properties, hydraulic fluxes, and initial 
conditions for transient analysis. The three-dimensional 
finite-difference ground-water-flow model MODFLOW-88 
(McDonald and Harbaugh, 1988) was used most extensively. 
Vertical variations in head within each model layer were 
assumed to be negligible, and head losses between layers 
were assumed to be controlled by confining beds near the 
base of each layer. Therefore, model-simulated heads were an 
approximate average of heads within that aquifer layer.
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According to Garabedian (1992), the regional aquifer 
system was subdivided vertically into four model layers. The 
layers were assigned equal thicknesses because differentiating 
the predominantly basalt aquifer system into distinct 
geohydrologic units was not possible. Layer 1 represents the 
upper 200 ft of the aquifer system; layer 2 is the next 300 ft 
below. Layers 1 and 2 contain Quaternary basalt of the Snake 
River Group and Tertiary basalt. Layers 3 and 4, are of lesser 
areal extent, and they are present only where basalt of the 
Snake River Group and interlayered sedimentary rocks are 
greater than 500-ft thick. Layer 3 is ≤500 ft in thickness, and is 
present only across the central part of the plain. Layer 4 ranges 
in thickness from 0 to about 3,000 ft in the central part of the 
plain.

Local aquifers perched above the regional aquifer 
system were not simulated, although recharge to perched 
aquifers was assumed to reach the regional aquifer. Vertical 
hydraulic conductivity was assumed to be anisotropic, owing 
to low-hydraulic-conductivity basalt between permeable 
flow tops and fine-grained layers within sand and gravel 
zones. Horizontal hydraulic conductivity was assumed to 
be isotropic because two-dimensional simulations indicated 
small differences in modeling results between isotropic and 
anisotropic conditions.

A steady-state model was constructed using 1980 water-
year fluxes (Garabedian, 1992, table 16). The 1980 fluxes 
were assumed to approximate the average annual flux for 
1950–80. During that period, hydrologic conditions were 
stable relative to conditions from 1880 to 1950. Ground-
water recharge was assumed to equal discharge (steady-state 
conditions) from 1950 to 1980 because irrigation diversions 
and ground-water levels were assumed to be stable relative to 
conditions from 1880 to 1950 (Garabedian, 1992, fig. 8 and pl. 
4). Declines in ground-water-level due to pumping, climatic 
variations, and decreased surface-water diversions during that 
period were generally small, and changes in storage were 
accordingly small (about 1 percent). These small changes 
in storage were included as a part of the recharge term by 
including them in the computation of approximate steady-state 
fluxes. Recharge from irrigation was assumed to take place 
directly below surface-water-irrigated areas.

Initial conditions were approximated by the steady-state 
solution obtained after removing recharge due to surface-
water irrigation and discharge by ground-water pumping from 
the calibrated 1950–80 steady-state model. Surface-water 
altitudes, used in the model for river-leakage simulations, were 
corrected for pre-reservoir conditions. The estimated pre-
irrigation steady-state condition was a stable initial condition 
for transient simulation. Therefore, simulated changes in 
head and discharge were assumed to result from changes in 
model input fluxes rather than from non-equilibrium initial 
conditions.

Subregional Model Development

To develop the subregional model used in this report, we 
converted the calibrated ESRP flow model from Modflow- 88 
to MODFLOW 2000 (Harbaugh and others, 2000). Initial 
model runs were made on the calibrated regional model 
to calculate the quantity of ground-water flow across a 
newly-defined upgradient subregional model boundary. This 
boundary was set near the western boundary of Minidoka 
County at column 25 in the ESRP model (Garabedian, 1992).

We then “clipped” the ESRP RASA model grid to this 
new upgradient boundary. The original ESRP model grid was 
divided into square cells approximately 4 mi per side. After 
the model area was reduced, the model area was rediscretized 
with each grid cell divided into approximately 1-mi square 
cells. Therefore, the number of grid cells increased by 16 
times. A schematic drawing of this operation is illustrated in 
figure 2.

The subregional model includes only the western portion 
of the ESRP model. Flow values across column 25 of the 
ESRP model were input as constant flow into the subregional 
model cells along the upgradient boundary. The flow was 
input into these cells as line wells. The model was run with 
this new configuration and resultant water levels and budget 
values were checked against the original model. Results were 
nearly identical to the original model.

No changes were made to the model configuration that 
affected ground-water elevations, discharge from springs, 
recharge sources, and other critical values or conditions. Also, 
we did not change the hydraulic parameters from the original 
ESRP model. The only change to the subregional flow model 
resulted from the use of a much smaller grid cell size than the 
one used in the ESRP model. The ESRP model incorporated 
the use of wells as recharge sources. Because of the smaller 
grid size used in the subregional model, we needed to increase 
the number of cells into which recharge was input in order to 
more accurately incorporate the recharge volume; otherwise, 
the model would not match the original results. Therefore, 
the total volume of recharge remained the same as in the 
ESRP model, but this volume was distributed over 16 times 
the number of recharge wells. Wherever possible, we placed 
these additional recharge wells in the rediscretized adjacent 
grid cell blocks. The volume of each original recharge well 
was evenly distributed between the 16 smaller cells. A few 
minor adjustments in the locations of these new recharge wells 
were needed so the new simulations matched the original 
simulations, especially along the model boundary.

Development of the Snake River Nitrate Scenario Simulator  �



Figure �. Extent of a subregional ground-water flow model of the mid-Snake region within the eastern Snake River Plain regional 
model environment.
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Solute Transport Modeling

We simulated the transport of dissolved nitrate in 
the mid-Snake region’s ground-water system by using the 
USGS three-dimensional solute-transport model MOC3D 
(Konikow and others, 1996, Kipp and others, 1998), which 
was developed for use with MODFLOW 2000. MOC3D 
simulates three-dimensional solute transport in flowing ground 
water, computing changes in concentrations of a dissolved 
constituent over time that can be caused by factors such as 
advective transport, hydrodynamic dispersion, and mixing or 
dilution. MOC3D uses the method of characteristics to solve 
the transport equation for a given time step on the basis of 
hydraulic gradients computed with MODFLOW (Konikow 
and others, 1996, Kipp and others, 1998). Particle tracking is 
used within the model to represent advective transport. The 
conceptual model of nitrogen input developed by Skinner 
and Donato (2003) was used in the transport model as a GIS, 
nitrogen-input data layer. This nitrogen source layer was used 
to define nitrogen flux at the surface in the flow and transport 
model. The flow and transport models were simulated using 
steady-state conditions in three dimensions.

Data collected or compiled during recent and ongoing 
studies that define ground-water nitrate concentrations 
were used to refine the new model and to evaluate model 
calibration. All concentrations of nitrate are presented 
consistently as milligrams per liter of nitrite plus nitrate as 
nitrogen with negligible nitrite concentrations in the area.

Nitrogen Source Layer

Data used for nitrogen input into the solute transport 
model were calculated as a nitrogen-input layer during 
a separate study, and described in Skinner and Donato 
(2003). The input was updated to account for differences 
in study area extent between the two studies. This study’s 
area includes additional areas of Bingham, Blaine, Butte, 
Camas, Elmore, and Power Counties; and less area of Cassia, 
Gooding, Lincoln, and Twin Falls Counties. The areas of the 
original nitrogen-input layer not in this study’s area were 
simply “clipped off.” The expanded portions of this study 
area are primarily upgradient to the solute transport model, 
and represent background conditions for nitrogen input. 
We assigned nitrogen-input values to the expanded study 
area portions that corresponded to similar approaches in the 
adjacent counties (fig. 3).

Input from the nitrogen source layer was incorporated in 
the MOC3D transport model by using the area wells function 
in all active model cells in layer 1. The area wells function 

allows for the nitrogen source layer load to be introduced into 
the flow model by assigning a volumetric stress to each cell. 
The stress applied is a small volume of water that contains a 
specified concentration of nitrogen derived from the source 
layer. The initial pre-agriculture background concentration 
applied throughout the model was 0.5 mg/L in the upper 
model layer, 0.4 mg/L in the second and third underlying 
layers, and 0.3 mg/L in the fourth underlying layer. A very 
small stress term was initially given, and this term was 
adjusted based on available nitrogen in ground-water data 
in the USGS National Water Information System (NWIS) 
database. These data were used to refine the new model and to 
evaluate its calibration. The calibration points included about 
300 wells located throughout the model area, and 11 springs 
that discharge into the Snake River. The well data usually 
included one analysis per well. The data for most of the 
bedrock springs discharging from the aquifer included many 
analyses over numerous years (Clark and Ott, 1996). The 
model continued to be simulated as steady state because the 
additional stress term was small in relation to overall stresses.

Calibration of the transport results was accomplished 
by comparing areal nitrate concentrations results from the 
simulations with nitrate data from the wells and springs. No 
rigorous calibration techniques, such as parameter estimation, 
were used in the calibration process because such techniques 
likely would have required changes to the underlying 
hydraulic parameters in the already-calibrated ESRP model, 
which was not part of the process. Therefore, calibration was 
done mostly using trial and error techniques.

Calibration began by taking the nitrogen source layer 
as representing current source conditions, and then adjusting 
it to start in 1910. County agricultural statistics for the six 
counties that overlap with Skinner and Donato (2003) were 
used to determine the total numbers of agricultural acres 
and dairy cattle. Those statistics were used to approximate 
the percentage of current nitrogen load that could be used to 
represent the 90-year period. The amount of available nitrogen 
loading was increased during sequential model time steps by 
a factor related to those statistics (fig. 4). The result of the 
simulation, therefore, represents the end of a 90-year historical 
period simulation based on the increase in the area’s crop 
farming and the introduction and increase of dairy farms.

Comparing maps of measured ground-water nitrate 
concentration data from the Skinner and Donato (2003) 
study area and simulated ground-water nitrate concentration 
data from this study and graphs of measured and simulated 
spring nitrate concentration data showed that the model was 
reasonably able to simulate the general pattern of measured 
nitrate concentrations (fig. 5).

Development of the Snake River Nitrate Scenario Simulator  �



id3086_fig03

CUSTER

BLAINE

LINCOLN

CASSIA

UTAHNEVADA

POWER

BUTTE

TWIN  FALLS

CAMAS

GOODING

MINIDOKA

ELMORE

JEROME

BINGHAM

OWYHEE

ONEIDA

115°15' 115°00' 114°45' 114°30' 114°15' 114°00' 113°45' 113°30' 113°15' 113°00' 112°45'

42°15'

42°00'

42°30'

42°45'

43°00'

43°15'

43°30'

EXPLANATION0 10 20 30 40 MILES

0 10 20 30 40 KILOMETERS
Nitrate input, in pounds per acre per year

 Less than 56

 56 - 110

 111 - 165

 166 - 220

 Greater than 220

Original nitrogen input boundary

Study area boundary

SNAKE

RIVER

Lake
Walcott

R
a

ft

R
iv

er

Riv
er

R
iv

er

Li t
t l

e
W

oo
d

Big Wood

C
re

ek

Rock

C
reek

RockCreek
G

oo
se

Salmon Falls
Creek

Clover

Creek

Magic
Reservoir

Camas
Creek

American
Falls

Reservoir

Basemap modified from U.S. Geological Survey, 
digital data, 1:100,000, 1999
Transverse_Mercator projection
False_Easting: 500000.000000
False_Northing: 100000.000000
Central_Meridian: -114.000000
Scale_Factor: 0.999600
Latitude_Of_Origin: 42.000000
Horizontal datum is  North American Datum 1983

Figure �. Nitrogen loading input representing 1998 for the study area, south-central Idaho.
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The springs flow from a bedrock wall, in a range of 
elevation of hundreds of feet and are therefore represented in 
model layers 1 and 2. We input the vertical locations of these 
springs into the model, with most springs located in model 
layer 1. The results of simulations indicated that the model 
was capable of approximating the nitrate concentrations 
for springs in both model layers (fig. 6). Simulated nitrate 
concentration was about 0.5 mg/L higher than data collected 
for a 3-year period from Box Canyon Spring and showed 
similar intra-annual variability. Simulated results represent 
nitrogen loading conditions from the same period as the 
measured data. The simulated results were acceptable for the 
objective of this project and model to simulate regional nitrate 
variability in response to changes in proportions of nitrogen 
sources.

Simulation results indicated that the nitrogen source layer 
was not necessarily the driving factor in the resulting nitrate 
concentration map; rather, the ground-water velocity appeared 
to be the prime controlling factor (fig. 7). Some areas with 
large nitrogen loads and large ground-water velocities resulted 
in relatively small simulated nitrate concentrations, and other 

areas with relatively small nitrogen loads and small ground-
water velocities had large simulated ground-water nitrate 
concentrations. The simulated results reasonably represent the 
measured data.

Limitations

Data gathered from previous studies in the mid-Snake 
region, including USGS RASA and NAWQA programs, allow 
for the development and assessment of detailed conceptual and 
computer simulation models. These data and regional-scale 
RASA ground-water flow models are available for much of the 
Snake River Plain. Therefore, the approach used in this study 
is one potential assessment option for nitrate contamination 
issues in other areas of southern Idaho. However, the accuracy 
of such models will be limited because of the simplifying 
assumptions used in the models and uncertainty in model 
parameters. These limitations must be understood and 
considered when applying the model to resource-management 
issues.

Development of the Snake River Nitrate Scenario Simulator  �



id3086_fig05

Measured nitrate concentrations

Simulated nitrate concentrations

Nitrate concentrations,
 In milligrams per liter
  0-2
  2-4
  4-6
  6-8
  More than 8

EXPLANATION

LINCOLN

CASSIATWIN  FALLS

GOODING

M
IN

ID
O

K
A

JEROME

LINCOLN

CASSIATWIN  FALLS

GOODING

M
IN

ID
O

K
A

JEROME

Figure �. Measured and simulated nitrate concentrations (nitrite + nitrate as nitrogen) in the mid-Snake region, south-
central Idaho.

10  Evaluating Nitrogen Loading to and Nitrate Transport in Ground Water, Mid-Snake Region, South-Central Idaho



id3086_fig06

0.0

0.2

0.4

0.6

0.8

1.0

1.2

1.4

1.6

1.8

2.0

1999 2000 2001

YEAR

M
EA

SU
RE

D 
 N

IT
R

AT
E 

CO
N

CE
N

TR
AT

IO
N

S.
 IN

 M
IL

LI
G

R
A

M
S 

PE
R 

LI
TE

R
SI

M
U

LA
TE

D 
N

IT
R

AT
E 

CO
N

CE
N

TR
AT

IO
N

S.
 IN

 M
IL

LI
G

R
A

M
S 

PE
R 

LI
TE

R
A. Measured

B. Simulated

0.0

0.2

0.4

0.6

0.8

1.0

1.2

1.4

1.6

1.8

2.0

TIME EQUALS 3 YEARS

YEAR 1 YEAR 2 YEAR 3

Figure �. Measured and simulated nitrate concentrations (nitrite plus nitrate as nitrogen) at Box Canyon Spring, south-
central Idaho, 1999-2001.

Development of the Snake River Nitrate Scenario Simulator  11



Figure �. Simulated ground-water velocity from the subregional flow model in the mid-Snake region, south-central Idaho.
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Model Use and Guidance
A GUI was created to simplify the alteration and display 

of the flow and transport model described above. The GUI was 
created using ESRI’s royalty-free software MapObjects LT. 
The GUI provides a GIS interface for viewing and editing the 
nitrogen loading conditions, running the flow and transport 
model, and viewing the results of the modeling. The flow and 
transport model along with the GUI are collectively called the 
SRNSS. The components of the SRNSS and other associated 
files are available in a zip file that accompanies this report. 
One of the files, readme.txt, provides installation instructions. 
The appendix of this report provides detailed instructions for 
using the SNRSS software.

At startup, the SRNSS loads a base distribution of 
nitrogen loading and nitrate concentration distribution that 
represents the conditions in approximately the year 2000. 
The base-case run represents the end of a 90-year historical 
period simulation of the increase in the area’s farming and 
the introduction and increase of dairy farms. The increases in 
agriculture in the area are estimated from the U.S. Department 
of Agriculture’s Census of Agriculture. 

Users can then choose from predefined zones to 
increase or decrease the nitrogen loading for those zones by 
a multiplication factor of 0.1 to 5.0 (fig. 8). We delineated 
these predefined zones to maintain political, hydrological, 
and predominant land-use boundaries while preventing any 
one zone from becoming so small that the SRNSS could not 
simulate that zone effectively. For the same reason, the SRNSS 
does not allow users to create loading zones. After users edit 
the nitrogen loading zones, the SRNSS software prompts 
the users to run MODFLOW-MOC3D with the new nitrogen 
loading conditions. When MODFLOW-MOC3D completes its 
model run, the results are displayed in the simulator, allowing 
users to view the results in 5-year increments up to 30 years.

Altering the nitrogen loading factors simulates land-use 
changes for a zone. Nitrogen loads represent an entire 
zone that can contain multiple land-use types. Therefore, 
a change in nitrogen loading will represent a change from 
one predominant land use to another for the entire zone. 
The loading factor selected depends on the type of land-use 
change being modeled. For instance, a land-use change from 
rangeland to agriculture results in an increase in nitrogen 
loading that would be modeled by a loading factor between 
1 and 5, depending on the amount and extent of the land-
use change. Conversely, a land-use change from agriculture 
to residential results in a reduction of nitrogen loading and 
requires a loading factor between 0.1 and 0.9. Other typical 
land-use change scenarios would be to convert agricultural 
land to rangeland, resulting in a decrease of loading (or a 
loading factor between 0 and 1), or to increase the dairy cattle 
in an area, modeled with a loading factor between 1 and 5, 

depending on the magnitude of the increase in dairy cattle. 
Choosing appropriate loading factors for simulating land-use 
change is left to the user, however, some guidance is provided 
below.

The nitrogen loading values used by the flow and 
transport model are based on fertilizer, cattle manure (from 
dairy and beef operations), septic systems, atmospheric 
deposition (precipitation), and legume crops (alfalfa and 
beans), with the largest inputs coming from fertilizer and dairy 
cattle. The nitrogen input data also account for crop uptake 
of nitrogen, listed as crop losses. Nitrogen inputs are county-
level estimates except those for dairy cattle and atmospheric 
deposition. Table 1 lists the nitrogen input and loss values for 
each county and land-use type as estimated in Skinner and 
Donato (2003), and describes the loading values for the 30-
year run used to create the base case in the SRNSS flow and 
transport model. Table 2 lists the percentage of area that each 
nitrogen input type (except precipitation, which is 100 percent 
for each zone) occupies within each zone. Nitrogen input for 
dairy cattle was applied by determining spatial densities of 
dairy cattle from known dairy locations. Dairy cattle densities 
ranged from 1 to 450 animals per square mile with an increase 
of 33 lbs of nitrogen per acre per year for an increase of 50 
per square mile (fig. 9). A more complete explanation of the 
nitrogen-loading layer is provided in Skinner and Donato 
(2003).

An example change in nitrogen loading input follows in 
which the predominant land-use changes from rangeland to 
dairy agriculture. The high nitrogen input values in southern 
Gooding and western Jerome Counties are primarily due to 
dairy cattle inputs (figs. 3 and 9). To change the nitrogen-
loading estimate for other parts of Gooding County to mimic 
the introduction of similar dairy cattle facilities would increase 
nitrogen loading by a multiplication factor of 2 to greater 
than 4, depending on the original nitrogen input value. For 
example, the zone in northern Gooding County, primarily 
rangeland, would require a loading factor of 4 to resemble 
the nitrogen loading in southern Gooding County, primarily 
from dairy agriculture, (less than 55 lbs/acre/yr to greater than 
220 lbs/acre/yr).

In simulating changes in nitrogen inputs, be aware 
that the nitrogen inputs discussed above are general values 
representing large areas. Small spatial changes in land use 
cannot be simulated effectively with the SRNSS. However, 
large-area land-use changes occurring over long periods are 
ideal scenarios to simulate with the SRNSS.
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Figure �. Predefined nitrogen loading zones in south-central Idaho used in the SRNSS flow and transport model.
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Table 1. Nitrogen input values for source and land-use type for counties in the study area, south-central Idaho.

[Nitrogen input values from 1998 data. Nitrogen input by dairy cattle and precipitation were not estimated by county, but by their own spatial distributions. 
Dairy cattle input varies widely due to animal population densities. Inputs range from 0 to 232 pounds per acre per year (lb/acre)/yr). Precipitation inputs range 
from 1 to 6 (lb/acre)/yr, with most of the area receiving 2 (lb/acre)/yr.

County

Source and land-use type

Fertilizer
(agricultural and  

residential)

Crop losses
(agricultural)

Beef cattle
(agricultural)

Septic
(residential and  

commercial)

Legumes
(agricultural)

Cassia 130 -12 23 29 38
Gooding 67 -7 30 16 58
Jerome 101 -7 19 23 46
Lincoln 71 -8 16 13 41
Minidoka 140 -11 7 16 28
Twin Falls 90 -8 16 16 49

Table �. Percentage of area occupied by nitrogen source types in each zone of the study area, 
south-central Idaho.

{Percentage of area in square miles (mi2).

Zone
Zone Area 

(mi�)
Fertilizer Septic Legumes Beef Cattle Dairy Cattle

1 193 82 3 79 79 82
2 76 87 0 87 87 48
3 128 46 1 44 44 83
4 221 25 0 25 25 30
5 106 93 6 87 87 83
6 1,407 9 0 9 0 0
7 149 21 0 20 20 43
8 200 21 0 20 20 60
9 52 4 0 4 4 15

10 532 4 0 3 3 9
11 59 38 0 38 38 54
12 60 79 5 74 74 96
13 79 78 3 75 75 96
14 130 71 2 69 69 97
15 292 24 1 24 22 42
16 53 79 9 70 70 28
17 147 79 1 78 78 89
18 151 71 1 70 70 22
19 101 86 3 83 83 85
20 440 12 0 12 12 2
21 217 82 0 82 82 80
22 103 74 5 70 70 82
23 90 25 0 25 25 45
24 163 35 0 34 34 56
25 164 26 0 26 26 18
26 27 72 4 68 68 50
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Figure �. Nitrogen input range by dairy cattle by zone in south-central Idaho.
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This appendix provides the following information about 
the Snake River Nitrate Scenario Simulator (SRNSS):

Description of associated files.

Initial model settings.

Creating or selecting datasets.

Modifying nitrogen loading factors.

Running the transport model.

Customizing and viewing the nitrate scenario 
simulation.

Description of Associated Files

The simulator is packaged in a compressed zip file for 
faster download. Table A1 lists and describes the files that are 
included in the zip file.

•

•

•

•

•

•

The readme.txt file provides instructions for installing the 
SRNSS.

Initial Model Settings

When you start the SRNSS software, it loads the base 
case run shown in figure A1.

Appendix A. Detailed instructions for using SNRSS software.

Table A1. List of files included in the Snake River Nitrate 
Scenario Simulator zip file.

File/folder name Description

readme.txt Installation and setup instructions
SRNSS_setup.exe Installation program
MODFLOW_inputfile_pdfs Folder containing PDF files of the 

model input data

Figure A1. Screen showing base case for the Snake River Nitrate Scenario Simulator, using the spectrum color ramp and 
minimum/maximum nitrate concentration (nitrite plus nitrate as nitrogen) values set to 1 and 5, respectively.
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The base case run starts with conditions at the end of 
the 90-year historical period simulation (approximately year 
2000). The predictive base case simulation runs for 30 years 
with constant hydraulic and nitrogen loading conditions equal 
to those in year 2000. All datasets you create are based on 
the base case; the datasets differ only in the distribution of 
nitrogen loading, which you can scale up or down by applying 
a multiplication factor to any of the 26 pre-defined zones. All 
datasets are simulated for the same 30-year predictive period 
as the base case. You can view the nitrate distribution for each 
run, as well as the change in nitrate concentration in each cell 
relative to the base case simulation at the same point in time. 
All nitrate concentrations are nitrite plus nitrate as nitrogen 
with nitrite concentrations being negligible in the study area. 

In figure A1, the concentration colors have been set to show 
concentrations between 1 and 5 mg/L by a smoothly varying 
color range (blue-cyan-green-yellow-red). By default, cells 
with concentrations less than 1 mg/L plot as gray and those 
with values greater than 5 mg/L plot as red.

Creating or Selecting Datasets

The SRNSS lets you create and manage datasets for the 
flow and transport model. The options to create, select, and 
delete datasets are available from the simulator’s File menu 
(fig. A2).

Figure A�. Screen showing dataset management options available in the Snake River Nitrate Scenario Simulator.
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To Create a Dataset

Click File > New Dataset. The New Dataset dialog 
box displays. 
 
NOTE: By default, the software incrementally 
names each new dataset as CASE_# (where # 
represents an incremented number).

From the drop-down list, select the existing dataset 
on which to base the new dataset.

Click OK. The new dataset is created. You must now 
select that dataset to work with it.

1.

2.

3.

To Select a Dataset

Click File > Select Dataset. The Select Dataset 
dialog box displays, showing the map for the last 
currently selected dataset (fig. A3).

From the drop-down list on the right, select the 
dataset that you want.

Click Select. The dataset is displayed in the 
simulator (fig. A4).

To Delete a Dataset
WARNING: If you select the Delete Dataset option, the 

currently loaded dataset is deleted immediately and cannot be 
recovered.

Click File > Delete Dataset. The dataset is deleted from 
the simulator.

1.

2.

3.

Figure A�. Screen showing Select Dataset dialog box.
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Figure A�. Screen showing selected dataset loaded in the Snake River Nitrate Scenario Simulator.

Modifying Nitrogen Loading Factors

The SRNSS lets you modify the nitrogen loading factors 
for any or all of the 26 predefined zones of the mid-Snake 
region. Each zone’s loading factor may range from 0.1 to 5.0. 
Modifying loading factors lets you create various scenarios to 
model potential changes in nitrate concentrations throughout 
the mid-Snake region.

To Modify Nitrogen Load Factors

Click Dataset > Edit loading zones…. The Edit 
Loading Factors dialog box displays (fig. A5).

1.

Do one of the following:

To assign a value to an individual zone, click the 
cell for that zone, click Edit Cell Value, and then 
enter the desired value in the selected cell.

To assign a uniform loading value to all zones, 
enter the value in the text box at the top of the 
screen, and then click Assign Uniform Value.

3. Click Save. The case is updated with the modified 
load factors, and you are prompted to run the 
transport model.

2.

•

•
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Figure A�. Screen showing Edit Loading Factors dialog box.

Running the Flow and Transport Model

When you save changes to a dataset’s loading factors, the 
simulator prompts you to run MODFLOW 2000, which in turn 
runs the flow and transport model (MOC3D). However, you 
can run the model at any time.

Click Dataset > Run MODFLOW (fig. A6). The 
Run MODFLOW dialog box displays.

Click Yes. MODFLOW 2000 runs the transport 
model MOC3D in a command window (fig. A7).

The simulations take about 15 minutes to run on a 1.7 
GHz Pentium 4 computer. After the MODFLOW simulation 
is complete, the map display is updated with the new 
concentration values (fig. A8).

1.

2.

Viewing the Nitrate Scenario Simulation

When the model run completes, the simulator displays 
the results. You can then simulate potential increases in nitrate 
concentrations in shallow ground water by selecting time 
periods ranging from 5 to 30 years. Also, as you move the 
cursor around the map, note that the status bar at the bottom 
of the window displays the row-column position of the mouse 
pointer on the plot. As you hover the mouse pointer over a 
zone, the status bar displays that zone’s nitrate concentration 
values for both the selected dataset (CASE_1 in this example) 
and the base case, as well as the change in concentration 
between the two cases (fig. A4)

Appendix A  ��



Figure A�. Screen showing the Run MODFLOW option in the Snake River Nitrate Scenario Simulator.
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Figure A�. Screen showing MODFLOW 2000 running the MOC3D flow and transport model for the Snake River Nitrate 
Scenario Simulator.
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Figure A�. Screen showing plotted results of the MOC3D simulation displayed in the Snake River Nitrate Scenario Simulator.

Customizing the Simulator Display

The SRNSS provides several options for customizing and 
viewing the nitrate scenario simulations resulting from model 
runs. These options include:

Showing and hiding the model grid.

Showing and hiding basemap layers for cities, counties, 
lakes, roads, and streams.

Selecting rendering options.

Zooming and panning.

•

•

•

•

To Show and Hide the Model Grid and Basemap 
Layers

You can customize the simulation plot by showing or 
hiding the model grid and the individual basemap layers. 
These options are available from the View menu (fig. A9).
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To Select Rendering Options
To change the display of nitrate concentration values, 

select View > Renderer…. The Renderer Properties 
dialog box lets you select minimum and maximum nitrate 
concentration values and a color ramp for displaying those 
concentrations (fig. A10). You also can specify colors in 
which to display values that fall below or above the defined 
range. In the example shown in fig. A10, a Spectrum color 
ramp is selected for data values between 1 and 5 mg/L. Values 
less than 1 mg/L will display in gray, and values greater than 
5 mg/L will display in red. By experimenting with the data 
range and colors, you can focus on different aspects of the 
simulation data.

To Zoom and Pan
The plot can be zoomed by selecting the Zoom tool from 

the toolbar and dragging a rectangle over the area of interest 
(fig. A11). The plot will then zoom to that extent (fig. A12). 
You can pan the view of the simulation either by using the 
scrollbars on the map or by selecting the Pan tool from the 
toolbar, holding down the left mouse button, and then dragging 
the mouse. To return to the full view of the simulation, click 
the globe button on the toolbar.

To Export a Map Image
The SRNSS software easily allows a user to export 

an image of the display by selecting File > Export Map 
(fig. A13). This saves an image of the display to the 
computer’s clipboard or temporary memory to be pasted into 
another application. This tool does not permanently save a 
copy of the image to the computer disc.

Figure A�. Screen showing customizing the display in the Snake River Nitrate Scenario Simulator.
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Figure A10. Screen showing options available in the Renderer Properties dialog box.
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Figure A11. Screen showing use of the Zoom tool in the Snake River Nitrate Scenario Simulator.
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Figure A1�. Screen showing a zoomed view in the Snake River Nitrate Scenario Simulator.
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Figure A1�. Screen showing use of the export map tool in the Snake River Nitrate Scenario Simulator.
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